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2 PRODUCT CODE

Model: TU-RS485-ETH  IO DL
 1 serial interface RS-485 Modbus RTU Master

 1 serial interface RS-485 Modbus RTU Slave

 1 slot for USB Memory

 Interface Ethernet 10Base-T, Modbus TCP

 N.4 Digital Inputs

 N.2 SPDT Relays

 Galvanic Isolation on all the ways

Model: TU-RS485-ETH ANL
 1 serial interface RS-485 Modbus RTU Master

 1 serial interface RS-485 Modbus RTU Slave

 1 slot for USB Memory

 Interface Ethernet 10Base-T, Modbus TCP

 Galvanic Isolation on all the ways

 1 Universal Analogue input

 1 Voltage/current Input

 2 Passive Analogue output

 2 Digital Inputs

 N.2 SPDT Relays

 Transmitter Power Supply

3 HARDWARE INSTALLATION
The TU-RS485/ETH series is suitable for fitting to DIN rails in the vertical position.
For optimum operation and long life follow these instructions:
When the devices are installed side by side it may be necessary to separate them by at least 5 mm in
the following case:
If panel temperature exceeds 45°C and high power supply value( > 27Vdc).
Make sure that sufficient air flow is provided for the device avoiding to place raceways or other objects which
could obstruct the ventilation slits. Moreover it is suggested to avoid that devices are mounted above appliances
generating heat; their ideal place should be in the lower part of the panel.
Install the device in a place without vibrations.
Moreover it is suggested to avoid routing conductors near power signal cables (motors, induction ovens,
inverters, etc...) and to use shielded cable for connecting signals.
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4 Software Configurator

DevTU is an Integrated Development Environment running under the  Windows® Operative System that allows
to design and debug the applications based on the TU-RS485-ETH series control devices.
With DevTU it is possible to set the TU-RS485-ETH series controllers to execute I/O read and write operations
(TU-E3000 series), mathematical and logic operations and timers.
Moreover it is possible to read and write in real time the Internal Registers of the Controller or connect it directly
to the slave devices connected to its Modbus Master Port.

4.1 SOFTWARE INSTALLATION

4.1.1 MINIMUM SYSTEM REQUIREMENTS

Operative System Windows® 2000 / NT / ME / XP/ Vista / Win 7
Available Hard Disk memory 2 MB

4.1.2 PROCEDURE

 Close eventual active or background applications.

 Insert the CD-ROM of installation in the driver.

 Wait for the Autorun window opening.

 If the Autorun function is disabled, open the CD-ROM and execute the installation file at the path:

 <CD Driver>:/doc/download.html

 Click on the Tools button.

 Click on the “download”  button in the TU-RS485-ETH section.

 Follow the Installation Wizard.
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4.2 DevTU WINDOW

In the Main Window of DevTU the following components are shown:
 The Menu bar, the Tool bar and the Status bar (Fig.1.1-A)
 The Log window (Fig.1.1-B)
 The Main Program window (Fig.1.1-C)
 The Registers Table (Fig.1.1-D)

Fig. 1

A

B

C

D
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4.3 TERMINOLOGY

Description of terms and abbreviations used in DevTU and in this manual.

Controller Device of the TU-RS485-ETH series.
Integrated Development Environment
IDE Instructions set to create, to debug and to test the Program.

Program List of functions executed from the Controller.

Function Block FB Each block constituting the Main Program. Each Function Block can
contain a function.

Function Logical, mathematical or flow operation executed from the Control-
ler.

Variable Each parameter contained in a function

Register Position of a variable in the volatile memory of Controller.

Retentive Register Position of a variable in the non-volatile memory of Controller.

Label String of characters used to identify the name of an object (Function
Block, Register, Table,...)
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4.4 PROJECT MANAGMENT

4.4.1 START A NEW PROJECT

Click on the “New Project” button (Fig.2.1-A) or select “ Project -> New ” in
the Menu bar.
The following windows will appear:
Log : empty window that will contain the operation

performed
(Fig.1.1-B).

Program : in this window it is possible to insert the Function
Blocks to generate the Program.
For a new Project this window contains a blank
Function Block. (Fig.1.1-C).

Registers Table :contains the list of Controller's Registers (Fig.1.1-D).

4.4.2 SAVE AND LOAD A PROJECT

To save the Project click on the “Save Project” button (Fig.2.1-C) or select
“ Project -> Save ” or “ Project -> Save As... ” in the Menu bar.
When a Project is saved for the first time, DevTU requires the file name
that will be used as name for the Project.
It will be created a main file with (.prj) extension and the system files
necessary for the correct working of the device.
To load a Project previously saved click on the “Open Project” button
(Fig.2.1-B) or select “ Project -> Open ” in the Menu bar. It will be loaded
the Program, the name and the types of the Registers and the eventual
tables, display windows and the scheduler objects .

4.4.3 CLOSE A PROJECT

To close an existing Project, select “ Project -> Close in the Menu bar.
When DevTU closes a project, it ask if the user want to save the changes
eventually done.
To close the software DevTU,select “ Project -> Exit in the Menu bar. It
asks if the user want to save the changes eventually done.

A

Fig. 2.1

B C
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4.5 WORK WITH THE FUNCTION BLOCKS

4.5.1 INSERT A FUNCTION BLOCK

To set a Function Block it is necessary to activate it, clicking inside the
block: the block is active when its border is highlighted in red .
It is possible to insert a new Function Block before or after the
highlighted block (Fig.2.3-A).
Click on the “Insert Before” button (Fig.2.2-A) to insert a new block
between the highlighted block and the previous .
Click on the “Insert After” button (Fig.2.2-B) to insert a new block
between the highlighted block and the successive.
The new block inserted will be automatically highlighted.

4.5.2 REMOVE A FUNCTION BLOCK

To remove a Function Block, click on the block to select it and then click
on the “Delete” button (Fig.2.2-H).

4.5.3 MODIFY A FUNCTION BLOCK

To modify a Function Block, click two times on the block or click on the
block to select it and then click on the “Modify” button (Fig.2.2-G).
The operations described above are also accessible from the menu that
appears clicking the right button of the mouse inside the highlighted
Function block.

4.5.4 MOVE A FUNCTION BLOCK

Click on the “Move Up” button (Fig.2.2-C) to change the position of the
active block and that one that precedes it.
Click on the “Move Down” button (Fig.2.2-D) to change the position of the
active block and that one that follows it.

4.5.5 ZOOM

The “Zoom” button (Fig.2.3-B) allows to change the scale of visualization
of the Main Program window reducing the dimensions of the Function
Blocks  ( Zoom - ) or turn back to the standard visualization ( Zoom + ).

B C DA

Fig. 2.2

E F G H

Fig. 2.3

A

B
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4.5.6 STRUCTURE OF A FUNCTION BLOCK

When the user modifies a Function Block, the “Function Block” window
(Fig.2.4) will be visualized; this allows to set the variables relative to the
Function selected.
The Functions are gathered in specific functional groups: to visualize
them, click on the button relative to a functional group (Fig.2.4-A) in
order to visualize its specific functions  (Fig.2.4-B).
Clicking on the button relative to the function to be inserted; it will appear
a menu where it is possible to set the Label and the Variables (Fig.2.4-C)
proper of the selected function.
To define particular variables like Masks or Tables, it is possible to use
the “Set” button to open a window of guided insertion of the value.
At the end, click on the “OK” button (Fig.2.4-D) to insert the function
inside the Main Program window.
In the Main Program window, the following parameters will be visualized:
Index (Fig.2.5-A): unique number that identifies the position of the block
inside the Program.
Label (Fig.2.5-B): unique label that identifies the Function Block inside
the Program (used for the functions of the “Flow” functional group, refer
to section “Function description”).
Symbol (Fig.2.5-C): icon relative to the function to be inserted.
Variable (Fig.2.5-D): parameter of  the Function Block.
Refer to the section “Function description” to know how to insert the
functions.

4.5.7 COPY A FUNCTION BLOCK

To copy a Function Block, select the Function Block to copy clicking on it,
click on the button “Copy” (Fig.2.6-A), create a new Function Block in the
desired point of the Project and than click on the button “Paste” (Fig.2.6-B)

It will be created a Block with the same properties of the original.

4.6 COMPILE AND ERROR CHECK

When the insertion of the Function Blocks is complete, it is possible to
compile the Program clicking on the “Compile ” button (Fig.2.7).
It will be created a report in the Log window (Fig.2.7) containing the
eventual errors and/or anomalies encountered during the error checking
procedure(Fig.2.8-A).
If the compiling process has a successful conclusion, the Log window
will show the memory resources in use by the Program (Fig.2.8-B).

NOTE:
It is possible to insert up to 255 func-
tion blocks and up to the available
memory capacity (Program Memory).

Fig. 2.4

A

B

C

D

Fig. 2.5

A
B C

D

BA Fig. 2.6

Fig. 2.8

A

B

Fig. 2.7
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4.7 INTERNAL REGISTERS

The Internal Memory of the Controller is composed of a 16 bit Register se-
ries divided as follows:

%S System Registers: contain the information about the status
Controller.

%R General Purpose Registers: can be used in the Program to
move the data or to execute calculation functions

%R

Retentive General Purpose Registers: can be used from the
Program to move the data or to execute calculation functions.
These Registers are saved in Eprom each time their values
change and they are uploaded when the Controller is pow-
ered-on.

Click on the “Watch” button (Fig.3.1) to visualize the Registers Table (Fig.3.2).
To update the Register's value, click on the “Read” button (Fig.3.2-A).
For each Register it is visualized:
The Register address (Fig.3.2-B)
The Register name (Fig.3.2-C)
The value contained into the Register (Fig.3.2-D)
The Register data format (Fig.3.2-E)

To modify the name or the value of a Register, click two times on the row
of table regarding the Register.
Inside the “Set” window (Fig.3.3) it is possible to set the name (Label) of the
Register (only for the General Purpose Register), to force the value con-
tained in the Register (only if the Controller is connected) and to set the
type of data format of the Register.
.

4.8 TYPE OF DATA FORMAT

Each General Purpose Register can be read or written using one of the
following data format :

Uint 16 bit Unsigned Integer (0 ÷ 65535)
Int 16 bit Signed Integer  (-32768 ÷ +32767)
Ulong 32 bit Unsigned Long (0 ÷ 4,294,967,295)
Long 32 bit Signed Long (-2,147,483,648 ÷ +2,147,483,647)
Float 32 bit Floating Point
Hex 16 bit Unsigned Integer visualized as Hexadecimal

characters (0000 ÷ FFFF)
ASCII 16 bit Unsigned Integer visualized as ASCII characters
Bin 16 bit Unsigned Integer visualized as binary code

K_Flt Floating Point Constant (as decimal)
K_Long Long Constant (as binary code)

NOTE: the 32 bit Registers request the position of 2 Registers.

Fig. 3.1

Fig. 3.2

AB C D E

Fig. 3.3
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4.9 MAPPING Register

Mapping modules TU-RS485-ETH IO DL

Register Description Access

%S0 --Reserved-- R/W

%S1 Firmware [0] R

%S2 Firmware [1] R

%S3 Name [0] R/W

%S4 Name [1] R/W

%S5 Port 1 [BaudRate] R/W

%S6 Node ID R/W

%S7 Port 1 [Timeout RX] R/W

%S8 Digital Inputs R/W

%S9 Digital Outputs R/W

%S10 System Flags R/W

%S11 --Reserved-- -

%S12 --Reserved-- -

%S13 PC R

%S14 Status [0] R

%S15 Status [1] R

%S16 COM Errors R/W

%S17 Gateway Mask [L-H] R/W

%S18 Port 0 [Settings] R/W

%S19 Port 2 [Settings] R/W

%S20 Timers Enable R/W

%S21 --Reserved-- -

%R22 --RTC(0) R/W

%R23 --RTC(1) R/W

%R24 --RTC(2) R/W

%R25 --RTC(3) R/W

%R26
…
%R959

General
Purpose
Registers R/W

%R928 Digital Input 0 Fre-
quency

R

%R929 Digital Input 1 Fre-
quency

R

%R930 Digital Input 2 Fre-
quency

-

%R931 Digital Input 3 Fre-
quency

%R932-933 Digital Input 0 Counter R/W

%R934-935 Digital Input 1 Counter R/W

%R936-937 Digital Input 2 Counter R/W

%R938-939 Digital Input 3 Counter R/W
%R960
…
%R1023

Memory
Registers R/W

Mapping modules TU-RS485-ETH ANL

Register Description Access

%S0 --Reserved-- R/W

%S1 Firmware [0] R

%S2 Firmware [1] R

%S3 Name [0] R/W

%S4 Name [1] R/W

%S5 Port 1 [BaudRate] R/W

%S6 Node ID R/W

%S7 Port 1 [Timeout RX] R/W

%S8 Digital Inputs R/W

%S9 Digital Outputs R/W

%S10 System Flags R/W

%S11 --Reserved-- -

%S12 --Reserved-- -

%S13 PC R

%S14 Status [0] R

%S15 Status [1] R

%S16 COM Errors R/W

%S17 Gateway Mask [L-H] R/W

%S18 Port 0 [Settings] R/W

%S19 Port 2 [Settings] R/W

%S20 Timers enabled R/W

%S21 --Reserved--- -

%R22 --RTC(0) R/W

%R23 --RTC(1) R/W

%R24 --RTC(2) R/W

%R25 --RTC(3) R/W

%R26 Analogue Input ch. 0 R

%R27 Analogue Input ch. 1 R

%R28-%R31 --Reserved-- -

%R32 Analogue output 0 R/W

%R33 Analogue output 1 R/W

%R34 Program. sensor ch. 0 &
1 R/W

%R35-%R927 “General Purpose” regis-
ters R/W

%R928 Digital Input 0 Frequency R

%R929 Digital Input 1 Frequency R

%R930-%R931 --Reserved-- -

%R932-933 Digital Input 0 Counter R/W

%R934-935 Digital Input 1 Counter R/W

%R936-%R941 --Reserved-- -

%R942-%R959 “General Purpose” regis-
ters R/W

%R960%R1023 Memory registers R/W
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4.10 TU-RS485/ETH  IO DL  and  TU-RS485/ETH ANL

Function of all models

4.10.1 SYSTEM REGISTERS OVERVIEW

This paragraph describes the working of the System Registers. Refer to the Registers Mapping relative to the
device in use to find out the position and the type of access to the Register.

4.10.1.1 FIRMWARE
Field of 2 read only Registers: contains the identifier firmware code provided from the manufacturer.

4.10.1.2 NAME
Field of 2 read/write Registers (4 bytes or 4 ASCII characters) at the user disposal: it can contain the name of
Controller or a unique code that identifies its function in the plant. Each one of the byte can contain any value
from 0 up to 255, the ASCII characters are included.
The default value of this field contains the identifier of the device in ASCII characters.

4.10.1.3 PORT 1 Baud Rate
Field of 1 read/write Register used to select the baud rate of the PORT 1 Modbus Master serial port. Set the
value in function of the following table

BaudRate(Baud) Value BaudRate(Baud) Value
1200 0 19200 4
2400 1 38400 5
4800 2 57600 6
9600 3 115200 7

4.10.1.4 NODE ID
Field of 1 read/write Register: contains the Modbus node address of the device;  the addresses allowed  are
from 1 up to 247.
Each device connected to the same net must have an unique address.

4.10.1.5 PORT 1 Timeout RX
Field of 1 read/write Register: contains the value of the delay time successive to the reception of the response
on the PORT1 Modbus Master; the value is expressed as milliseconds.

4.10.1.6 DIGITAL INPUTS
Field of 1 read/write Register: contains the status of the Digital Inputs (0 = OFF , 1 = ON).

4.10.1.7 DIGITAL OUTPUTS
Field of 1 read/write Register: contains the status of the Digital Outputs and allows to drive directly the Output
relays  (0 = OFF , 1 = ON) .

Bit

Descr.

Channel

15

-

14

-

13

-

12

-

11

#3

10

#2

09

#1

08

#0

07

-

06

-

05

-

04

-

03

-

02

-

01

-

00

-

Input

Bit

Descr.

Channel

15

-

14

-

13

-

12

-

11

-

10

-

09

#1

08

#0

07

-

06

-

05

-

04

-

03

-

02

-

01

-

00

-

Output
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4.10.1.8 SYSTEM FLAGS
Field of 1 read/write Register: contains the following system flags:
- PowerUp Event : this bit is forced to 1 at each Controller power-on. It is possible to set the value as 0 to
monitor eventual Controller reset events .

4.10.1.9 PC (Program Counter)
Field of 1 read only Register: shows the position of the instruction (Function Block) executed in the Main
Program . The value 0 is the first instruction (Function Block 1).

4.10.1.10 STATUS
Field of 2 read only Registers reserved for diagnostic operations.

4.10.1.11 COM ERRORS
Field of 1 read\write Register: is a counter of communication errors on the PORT1 Modbus Master. The value of
this Register is incremented each time that a query is sent on the Master Port and there is not response. This
value can be reset.

4.10.1.12 GATEWAY MASK
Field of 1 read/write Register: contains the range of Modbus addresses which the Controller can send to queries
on the PORT1 Master Port. If is requested to the Controller to send queries to an address out of this range, the
command won't be executed.

4.10.1.13 PORT 0 Settings
Field of 2 read/write Registers: contain the parameters “Baud-rate” and “delay time” (expressed as milliseconds)
of the serial PORT0 Slave Port. Set the value of the first Register in function of the following table:

Bit

Descr.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

First address of the Mask Last address of the Mask

Bit

Descr.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Baud Rate Delay (0÷255)

BaudRate
1200
2400
4800
9600
19200
38400
57600
115200

Value
0
1
2
3
4
5
6
7
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4.10.1.14 TIMERS Enable
Field of 1 read/write Register. Each bit of this Register is associated to an internal Timer. The Timer starts to
count when the associated bit is set as 0; when the parameter “ time” of the Timer Function Block set for the
Timer has passed, the Timer stops to count and the associated bit is automatically forced to 1.

4.10.1.15 RTC (Real Time Clock/Calendar)
Field of 4 read/write Registers: contain the value of the internal clock.
The following information are available:

 Seconds 00 ÷ 59
 Minutes 00 ÷ 59
 Hours 00 ÷ 23
 Day of week 01 ÷ 07 (01=Sunday, 02=Monday, .... 07=Saturday)
 Date 01 ÷ 31 (it depends on the month)
 Month 01 ÷ 12 (01=January, 02=February, .... 12=December)
 Year 00 ÷ 99 (00=2000, 99=2099)

NOTE: all of the values are expressed as hexadecimal characters .
NOTICE! Writing these Registers will imply the variation of the clock and calendar settings.

Bit

Descr.

Channel

15

T7

14

T6

13

T5

12

T4

11

T3

10

T2

09

T1

08

T0

07

T15

06

T14

05

T13

04

T12

03

T11

02

T10

01

T9

00

T8

Timers

Bit

RTC[0]

RTC[1]

RTC[2]

RTC[3]

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Seconds [0÷59]

Minutes [0÷59] Hours [0÷23]

Day of week [1÷7] Date [1÷31]

Month [1÷12] Year [0÷99]
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4.11 TU-RS485/ETH ANL only

Function only in TU-RS485/ETH ANL model

4.11.1.1 Analogue Input measure
Contains the measures of the inputs programmed in the register %R34.
Description Register
channel 0 %R26
channel 1 %R27

4.11.1.2 Analogue output values
Contain the value to set in Integer format for the two output currents.
Number for 4 mA: 4000; number for 20 mA = 20000
Description Register
channel 0 %R32
channel 1 %R33

4.11.1.3 FREQ [x]
Contains the measure of each digital input's frequency.
The resolution is 0.01Hz.
Description Register
channel 0 %R928
channel 1 %R929

4.11.1.4 COUNTER [x]
Contains the pulse counter (32 bit) each digital input.
Each counter is automatically incremented at each rise front of the relative digital input.
Description Register
channel 0 %R932 + %R933
channel 1 %R934 + %R935
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4.11.1.5 Input type programming (%R34)
Contain the programming of the two analogue input channels.
Bit 0-7: programming input channel 0 (universal input).
Bit 8-15: programming input channel 1(Volt – mA input).

INPUT TYPE PROGRAMMING TABLE

100 mV 1

Input type
Dec. value
Input type Channel 0

10 V 2
20 mA 3
Tc J 4

5
6
7
8
9
10
11

----------- 0 YES

Res 600 Ω 12
Pt100 13

Pt1000 14
Ni100 15

Ni1000 16
Potentiometer 17

Res 2000 Ω 18

Tc K
Tc R
Tc S
Tc T
Tc B
Tc E
Tc N

Bin. value
Input type

00000000
00000001

00000010
00000011
00000100
00000101
00000110
00000111
00001000
00001001
00001010
00001011
00001100
00001101
00001110
00001111
00010000
00010001
00010010

0x01

Hex. value
Input type

0x02
0x03
0x04
0x05
0x06
0x07
0x08
0x09
0x0A
0x0B

0x00

0x0C
0x0D
0x0E
0x0F
0x10
0x11
0x12

NO

NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO
NO

Channel 1

YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES
YES

YES
YES
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4.12 FUNCTION LIST

Functions selection tree, divided per functional group

COMM “Communication” functions

Read
Holding

Modbus function  “Read Holding Registers” (4xxxx , command 0x03)

Read
Input

Modbus function “Read Input Registers” (3xxxx , command  0x04)

Write Modbus function “Write Holding Registers” (4xxxx , command  0x16)

Read
TU-E 3000

Read values from the TU-E 3000 series

Write
TU-E 3000

Write values to the TU-E 3000 series

MOVE “Move” functions

Move Moves the value of an Internal Register or kostant in a new Register without to change the original
value.

Bitwise “Logical operations” functions

AND (bit) AND between two bits.
OR (bit) OR between two bits.

XOR (bit) XOR between two bits.
AND (word) AND between two words (Registers).
OR (word) OR between two words (Registers).

NOT Inversion of one or more bits.

Bit Set Forces to 1 one or more bits.

Bit Reset Forces to 0 one or more bits.

XOR (word) XOR between two words (Registers).

SHIFT “Logical operations” functions

Shift R “Shift to Right” a word (Register) .

Shift L “Shift to Left” a word (Register).

Rotate R “Rotate to Right” a word (Register).

Rotate L “Rotate to Left” a word (Register).
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MATH “Math” functions

Add Add two values.
Sub Subtract two values.

Mult Multiply two values.
Div Divide two values.

Scale Proportional scale adaption.
SQRT Square Root Extraction.

Average Calculation of the Arithmetic Mean of two or more values.
Linearization Linearization function of a Register's value following a linearization table.

ABS Calculation of the absolute value.
e^(x) Exponential function.
x^y Raise X to the Y power.

COMP “Comparison” function

Trip

FLOW “Flow” functions

GOTO
If (bit) goto

Call
Return

Timers “Timing” function

Timer Activation of an Internal Timer
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Read Holding Read the Holding Registers from a Modbus slave device

Reads the values of N holding Registers (Modbus function 0x03, Registers 4xxxx ) from a Modbus slave
device and writes the values in the selected Internal Registers. In case of missing response or wrong
response by the slave device, the Registers of destination are not updated and the value of the System
Register “COM Errors” is increased.

Variables:

Address Modbus address of the slave device (1÷247)
Register Address of the first Register to read (the mapping Registers starts from 0)
Num Numbers of Registers to read (1÷16)
Dest Address of the first Internal Register wherein the read values are written to.
Delay Delay time between the reception of the response and the execution of the next instruction

Write Write the Holding Registers of a Modbus slave device

Writes the values of N Internal Registers in N Holding Registers of a Modbus slave device (Modbus function
0x16, Registers 4xxxx ). In case of missing response or wrong response by the slave device, the Registers of
destination are not updated and the value of the System Register “COM Errors” is increased.

Variables:

Address Modbus address of the slave device (1÷247)
Register Address of the first Register to write (the mapping Registers starts from 0)
Num Numbers of Registers to write (1÷16)
Source Address of the first Internal Register from which the values to write are withdraw from.
Delay Delay time between the reception of the response and the execution of the next instruction.

Read3000 Read the I/O Registers from a Modbus slave TU-E3000 series device

Reads the I/O values from a Modbus slave TU-E3000 series device and writes the values in the Internal
Registers. The function will generate the proper Modbus command and will process the response.
In case of missing response or wrong response by the slave device, the Registers of destination are not
updated and the value of the System Register “COM Errors” is increased.
Refer to the technical documentation of the TU-E3000 series device for the complete description of the I/O
Registers.

Variables:

Device Selection of the TU-E3000 series slave device.
Address Modbus address of the slave device (1÷247).
Resource Type of data to read (analog inputs, digital inputs , etc...)
From First Resource to read.
To Last Resource to read.
Dest Address of the first Internal Register wherein the read values are written to.
Delay Delay time between the reception of the response and the execution of the next instruction.

Read Input Read the Input Registers from a Modbus slave device

Reads the values of N input Registers (Modbus function 0x04, Registers 3xxxx ) from a Modbus slave device
and writes the values in the Internal Registers. In case of missing response or wrong response by the slave
device, the Registers of destination are not updated and the value of the System Register “COM Errors” is
increased.

Variables:

Address Modbus address of the slave device (1÷247)
Register Address of the first Register to read (the mapping Registers starts from 0)
Num Numbers of Registers to read (1÷16)
Dest Address of the first Internal Register wherein the read values are written to.
Delay Delay time between the reception of the response and the execution of the next instruction.
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Move Move the value of an Internal Register or Constant in a new Register without to change the original value.

Writes in an Internal Register the value of a Constant (pre-set) or the value of another Register (copy). The
value will be converted to the format selected for the Register of destination. The address of the source
Register and the address of the Register of destination can be the same (modify the format of the Register).

Variables:

Source Constant or Internal Register from which the value is read.
Dest Internal Register wherein the value is written.

And (word) Executes the logical operation “AND” between two values.

Executes the logical operation “AND” between a Register and a constant (mask) or between two Registers.
The value will be converted to the format selected for the Register of destination. The address of the source
Register and the address of the Register of destination can be the same (modify the format of the Register).
After the execution of the logical operation, only the bits set as 1 in the mask will be forced; the bits set as 0
won't be modified. In case of a 32 bit source Register or constant (long) and a 16 bit Register of destination
(integer), the most significant bits will be ignored. It is possible to use this function to force one or more bits of
a Register as 0 ( in the mask set as 0 the bits to force, set as 1 the other bits ).

Variables:

Source  A Constant or Internal Register relative to the first operator.
Source  B Constant or Internal Register relative to the second operator.
Mask Out Mask applied to the result.
Dest Internal Register wherein the result is written.

Or (word) Executes the logical operation ”OR” between two values.

Executes the logical operation “OR” between a Register and a Constant (mask) or between two Registers.
The value will be converted to the format selected for the destination Register. The address of the source
Register and the address of the Register of destination can be the same (modify the format of the Register).
After the execution of the logical operation only the bits set as 1 in the mask will be forced; the bits set as 0
won't be modified. In case of a 32 bit source Register or constant (long) and a 16 bit Register of destination
(integer), the most significant bits will be ignored. It is possible to use this function to force one or more bits of
a Register as 1 ( in the mask set as 1 the bits to force, set as 0 the other bits ).

Variables:

Source  A Constant or Internal Register relative to the first operator.
Source  B Constant or Internal Register relative to the second operator.
Mask Mask applied to the result.
Dest Internal Register wherein the result is written.

Write3000  Write the I/O Registers of a Modbus slave TU-E3000 series device

Writes the values of N Internal Registers in the I/O Register of a Modbus slave TU-E3000 series device. The
function will generate the proper Modbus command and will process the response. In case of missing
response or wrong response by the slave device, the Registers of destination are not updated and the value of
the System Register “COM Errors” is increased.
Refer to the technical documentation of the TU-E3000 series device for the complete description of the I/O
Registers.

Variables:

Device Selection of the TU-E3000 series device.
Address Modbus address of the slave device (1÷247)
Resource Type of data to write  (analogue outputs, digital outputs, etc...)
From First Resource to write.
To Last Resource to write.
Source Address of the first Internal Register from which the values to write are withdraw from.
Delay Delay time between the reception of the response and the execution of the next instruction.
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And (bit) Executes the logical operation “AND” between two bits.

Executes the logical operation “AND” (bit to bit) between a Register and a Constant (mask) or between two
Registers. The value will be converted to the format selected for the Register of destination. The address of
the source Register and the address of the Register of destination can be the same (modify the format of the
Register). After the execution of the logical operation only the bits set as 1 in the mask will be forced ; the bits
set as 0 won't be modified. In case of a 32 bit source Register or Constant (long) and a 16 bit Register of
destination (integer), the most significant bits will be ignored.

Variables:

Source  A Constant or Internal Register relative to the first operator.
Mask A Bits of the first operator
Source  B Constant or Internal Register relative to the second operator.
Mask A Bits of the second operator
Dest Internal Register wherein the result is written.
Mask Out Mask applied to the Register of destination.

Or (bit) Executes the logical operation “OR” between two bits.

Executes the logical operation “OR” (bit to bit) between a Register and a constant (mask) or between two
Registers. The value will be converted to the format selected for the Register of destination. The address of
the source Register and the address of the Register of destination can be the same (modify the format of the
Register). After the execution of the logical operation only the bits set as 1 in the mask will be forced; the bits
set as 0 won't be modified. In case of a 32 bit source Register or constant (long) and a 16 bit Register of
destination (integer), the most significant bits will be ignored.

Variables:

Source  A Constant or Internal Register relative to the first operator.
Mask A Bits of the first operator
Source  B Constant or Internal Register relative to the second operator.
Mask A Bits of the second operator
Dest Internal Register wherein the result is written.
Mask Out Mask applied to the Register of destination.

Xor (word) Executes the logical operation “XOR” (Exclusive Or) between two values.

Executes the logical operation “XOR” between a Register and a constant (mask) or between two Registers.
The value will be converted to the format selected for the Register of destination. The address of the source
Register and the address of the Register of destination can be the same (modify the format of the Register).
After the execution of the logical operation only the bits set as 1 in the mask will be forced ; the bits set as 0
won't be modified. In case of a 32 bit source Register or constant (long) and a 16 bit Register of destination
(integer), the most significant bits will be ignored. It is possible to use this function to invert (NOT) one or more
bits of a Register ( in the mask set as 1 the bits to invert, set as 0 the other bits ).

Variables:

Source  A Constant or Internal Register relative to the first operator.
Source  B Constant or Internal Register relative to the second operator.
Mask Out Mask applied to the result.
Dest Internal Register wherein the result is written.
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Shift R Shift to right the bits of a Register .

Executes the shift of a Register to right: all of the bits are shifted of N positions to right. The most significant
bits will be forced to 0.

Variables:

Source Internal Register containing the value.
N Number of shift to execute.
Dest Internal Register wherein the result is written.

Shift L Shift  to left  the bits of a Register.

Executes the shift of a Register to left: all of the bits are shifted of N positions to left. The least significant bits
will be forced to 0.

Variables:

Source Internal Register containing the value.
N Number of shift to execute.
Dest Internal Register wherein the result is written.

NOT Executes the inversion of one or more bits of a Register.

Executes the inversion of one or more bit of a Register. After the execution of the logical operation will be
forced only the bits set as 1 in the mask; the bits set as 0 won't be modified.

Variables:

Source Internal Register containing the value.
Dest Internal Register wherein the result is written.
Mask Out Mask applied to the Register of destination.

XOr (bit) Executes the logical operation  “XOR” (Exclusive Or)  between two bits.

Executes the logical operation “XOR” (bit to bit) between a Register and a constant (mask) or between two
Registers. The value will be converted to the format selected for the Register of destination. The address of
the source Register and the address of the  Register of destination can be the same (modify the format of the
Register). After the execution of the logical operation only the bits set as 1 in the mask will be forced ; the bits
set as 0 won't be modified. In case of a 32 bit source Register or constant (long) and a 16 bit Register of
destination (integer), the most significant bits will be ignored.

Variables:

Source  A Constant or Internal Register relative to the first operator.
Mask A Bits of the first operator
Source  B Constant or Internal Register relative to the second operator.
Mask A Bits of the second operator
Dest Internal Register wherein the result is written.
Mask Out Mask applied to the Register of destination .
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Add Calculates the sum of two values

Calculates the sum between an Internal Register and a constant or between two Internal Registers.

Variables:

Source A Constant or Internal Register relative to the first operator.
Source B Constant or Internal Register relative to the second operator.
Dest Internal Register wherein the result is written.

Sub Calculates the difference of two values

Calculates the difference between an Internal Register and a constant or between two Internal Registers.

Variables:

Source A Constant or Internal Register relative to the first operator.
Source B Constant or Internal Register relative to the second operator.
Dest Internal Register wherein the result is written.

Mult Calculates the multiplication of two values

Calculates the multiplication between an Internal Register and a constant or between two Internal Registers.

Variables:

Source A Constant or Internal Register relative to the first operator.
Source B constant or Internal Register relative to the second operator.
Dest Internal Register wherein the result is written.

Rotate L Rotates  to left the bits of a Register.

Executes the rotation of a Register to left: all of the bits are shifted of N positions to left. At each shift the least
significant bit receives the value of the most significant bit.

Variables:

Source Internal Register containing the value
N Number of shift to execute.
Dest Internal Register wherein the result is written.

Rotate R Rotates  to right the bits of a Register.

Executes the rotation of a Register to right: all of the bits are shifted of N positions to right. At each shift the
most significant bit receives the value of the least significant bit.

Variables:

Source Internal Register containing the value.
N Number of shift to execute.
Dest Internal Register wherein the result is written.
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SQRT Calculates the Square Root of a value

Calculates the Square Root of a value contained in an Internal Register.

Variables:

Source Internal Register containing the value
Dest Internal Register wherein the result is written.

Average Calculates the Arithmetic mean of N values.

Calculates the Arithmetic mean of N Internal Registers values. (sum of the values / N).

Variables:

Source Address of the Internal Register containing the first value.
N Number of Internal Register of which calculate the mean.
Dest Internal Register wherein the result is written.

Linearization Calculates a value in function of a linearization table.

Calculates the Linearization of a value in function of the linearization table selected. Refer to the section
“Table” for more information.

Variables:

Source Internal Register containing the value to linearize.
Function Name of the Linearization table to be followed.
Dest Internal Register wherein the result is written.

Scale Executes the proportional scaling of a value

Executes the proportional scaling between the input range values and the output range values, referring to the
value of an Internal Register.

Variables:

Source Internal Register containing the value to scale.
Span In Maximum value of the input range
Zero In Minimum value of the input range
Dest Internal Register wherein the result is written.
Span Out Maximum value of the output range
Zero Out Minimum value of the output range

Div Calculates the division between two values.

Calculates the division between an Internal Register and a constant or between two Internal Registers.

Variables:

Source A Constant or Internal Register relative to the first operator.
Source B Constant or Internal Register relative to the second operator.
Dest Internal Register wherein the result is written.
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Trip  Control of a Trip Alarm

Controls a Trip Alarm with setting of the Trip level, hysteresis and delay time for ON and OFF condition. If the
input value is higher than the high trip level (MAX) for a time longer  than Ton, the bits selected in the output
mask will be forced to 1. If the input value is lower than the low trip level (MIN) for a time longer than Toff, the
bits selected in the output mask will be forced to 0.
It is possible to use this Function Block to execute the operation “A>B”: set the trip levels with the same value
and the delay times Ton and Toff = 0.
NOTE: the output status is updated at each execution of the Function after the end of the delay time: it is
suggested to insert this Function Block in a zone of the Program continuously executed.

The graph (Fig.4.1) shows the working of a Trip alarm that goes on if the input signal is higher than 100°C for at
least 2 seconds and goes off if the input signal is lower than 90°C for at least 5 seconds.

Variables:

Input Internal Register containing the value to compare
Max High Trip level
Min Low Trip level
Dest Internal Register wherein the result is written.
Mask Mask applied to the result.
Use Timer Number of Internal Timer to use (0÷15)
Timer On Delay time for Trip Alarm activation (ms)
Timer Off Delay time for Trip Alarm de-activation (ms)

Fig. 4.1
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Timers Activation of an Internal Timer
Sets an Internal Timer and starts to count. During the count, the bit relative to the Timer selected
in the System Register “Timers Enable”, will be forced to 0. At the end of the count, the bit will be
forced to 1.
It is possible to check the status of the bit to determine the end of the time set.

Variables:

Timer Number of the Internal Timer to enable
msec Timer Pre-set (milliseconds)
Reg If Timer = 0 is the value of time in msec.

Goto Unconditioned jump to a Function Block.

Executes an unconditioned jump to a Function Block. The Function Block recalled must have a unique Label.
It is possible to select the Label of the Function Block which jump to, sorting out it between those available in
the list box “Func.Block”. The list is automatically updated each time that the user identifies a new Block; in the
case of the list is empty the value 0 appears.

Variables:

Func.Block Pointer to the Function Block which jump to.

If (bit)  Conditioned  jump to a Function Block.

Executes a conditioned jump to the Function Block indicated in the variable “Goto if true” if the status of the bit
selected is 1, while if the status of the bit is 0 jumps to the Function Block indicated in the variable “Goto if
false”. All of the Function Blocks called must have a unique Label. It is possible to select the Label of the
Function Block which jump to, sorting out it between those available in the list box “Goto if true” and “Goto if
false” . The lists are automatically updated each time that the user identifies a new Block; in the case of the list
is empty the value 0 appears.

Variables:

Source Internal Register used as reference
Bit Number of the bit to control (0÷15)
Goto if True Pointer to the Function Block which jump to (if Bit=1)
Goto if False Pointer to the Function Block which jump to (if Bit=0)

Call Recall a Subroutine

Executes a jump to the first Function Block of a Subroutine; at the end of the Subroutine (command “Return”),
the Function Block successive to the block “Call” will be executed. The Function Block recalled must have a
unique Label. It is possible to select the Label of the Function Block which jump to, sorting out it between
those available in the list box “Func.Block”. The list is automatically updated each time that the user identifies
a new Block; in the case of the list is empty the value 0 appears.
NOTE: for each block “Call” must correspond a block “Return”, otherwise it is possible to occur in a “Stack
Overflow” error (refer to the section Troubleshooting).

Variables:

Func.Block Pointer to the Function Block which jump to

Return Return from a Subroutine

Indicates the end of a Subroutine. The Program will return to the Block following the  Function Block “Call”.
NOTE: for each block “Return” must correspond a block “Call”, otherwise it is possible to occur in a “Stack
Overflow” error (refer to the section Troubleshooting).
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4.13 INSERTION OF TABLES

To insert the linearization tables, it is necessary to open the proper win-
dow selecting “Tools -> Tables” in the Menu bar (Fig.5.1) .
To upload the points of a table from a file, click on the  “Load from File”
button (Fig.5.1-A); the parameters relative to the table like the name, the
number of points and the input and output values for each point will be
loaded.
Each table must be associated to a unique name that identifies the table
inside the Program when the user recall it: to modify the name, click on
the text box “Name” (Fig.5.1-B) and write the new name or select one be-
tween those existing.
The number of points (32 max.) defines the steps of linearization applied
to a variable.
To modify it click on the text box “N points” (Fig.5.1-C) and write the new
value: the window will be automatically updated.
Each point is defined by the input and output values. The input values
must be inserted in increasing order, while the output values can be in-
serted both in increasing and decreasing order.
The example (Fig.5.1-D) shows how to create an 8 points table to linear-
ize a RTD temperature sensor and to obtain the conversion Ohm/°C
(Fig.5.2) .

When the insertion of points is complete, it is possible to save the table in a
file, clicking on the “Save to File” button (Fig.5.1-E); by this command the name of the table, the number of points
and the input and output values per each points will be saved.
To insert the table inside the Program, click on the “>>” button (Fig.5.1-F). The “Table List” will be updated with the
name of the table just inserted and shows the tables available for the Program. To turn back to the Function
Block window, click on the “OK” button.
Select the Internal Register which the linearization curve will be associated to and  click on the “OK” button to
turn back to the Main Program window.
When the Function Block is recalled by the Program, the Controller executes a control between the value
contained into the Internal Register and the points of the selected table and calculates by interpolation the
output value.
In the example (Fig.5.1-D) for an input value of 1789 Ohm, will be calculated an output of 35 °C.

°C Ohm
0 1000
15 1145.6
20 1367.3
25 1532.7
30 1673.4
40 1904.5
50 1966.3
60 2000

Fig. 5.2
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4.14 SEARCHING OF THE DEVICES CONNECTED

Connect the Controller to the Ethernet network and power-on it (refer to
the data-sheet).
Open the window “Search” (Fig.6.1) selecting “Tools -> Search” in the Menu
bar. In this window it is possible to select the type of Controller to search
(Fig.6.1-A) and to set the receiving Time-out (time over which the device is
intended as not connected )- Fig.6.1-B. To search eventual devices
connected to the serial Modbus-master port of the Controller (Sub-Nodes),
the user must indicate the range of addresses to control (Fig.6.1-C); to use
this function it is necessary that the Controller is set in “Debug” modality
and in “Stop” condition.
When the options have been selected, click on the “Search” button (Fig.6.1-
D) to start the search. If necessary it is possible to interrupt the search
clicking on the “Stop” button.
When a Controller compatible with the type selected is recognized, it is
visualized in the Ethernet list (Fig.6.1-E), wherein it is possible to read the IP
address , the MAC address and the Modbus node of the device.
Afterwards, if required, the Modbus slave devices connected to the
Controller will be searched. The recognized devices will be visualized in
the Subnet list (Fig.6.1-F), wherein it will be possible to read the Modbus
slave node address and, in case of the TU-E3000 series devices, the
Firmware code. At the end of the search, it is possible to select one of the
Controllers detected clicking on its name and set it as default Controller,
clicking on the name by the right button of the mouse and selecting the
“Set as Controller” option; after this operation,the connection to the
Controller will be automatically executed. Refer to the next paragraph to
set the Controller manually.

4.15 CONNECTING TO THE CONTROLLER

Open the window “Settings” (Fig.6.2) selecting “Settings -> Controller” in the
Menu bar.
Set the following parameters:
Node ID :Modbus node address (1 ÷ 247)
Channel :Communication Interface (Ethernet or serial port)
IP Address :Controller IP address
Port :Modbus/TCP socket reserver port (502 for direct

connection)
Timeout :Receiving  Timeout for TCP commands
To confirm, click on the “OK” button.

Click on the “Connect” button (Fig.6.3-A): if the connection ends correctly,
the message “Connected” will be visualized in the Status bar Fig.6.3-B) and
in the Log window (Fig.6.4); in case of error, refer to the section
“Troubleshooting” to solve the problem.
From this moment all of the reading, writing, Programming and debugging
operations will be sent only to the selected Controller.
If the user have to change the Controller, it is necessary to disconnect the
Controller in use, click on the “Disconnect” button (Fig.6.3-C), modify the
parameters in the “Settings” window and then click on the “Connect” button
to communicate with the new Controller.

Fig. 6.1
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4.16 DOWNLOAD THE PROGRAM

When the Program is complete and if the compiling ends correctly it is
possible to download it in the RAM memory of Controller. To do it, open
the “Download” window (Fig.6.6). clicking on the  “Download” button
(Fig.6.5-A).
The Download operations are allowed only in “Debug” modality (refer to
the section “Debug Modality”).
Inside the “Download” window it is possible to set one or more options:
“Download Program” (Fig.6.6-A) – Starts to download the Program in the

RAM memory of Controller.
“Verify” (Fig.6.6-B) – Compares the Program contained in the RAM

memory with the compiled Program.
“Save in Flash” (Fig.6.6-C) – Transfers the Program loaded in the RAM

memory to the Internal Flash Memory of the Controller.
“Clear Register Memory” (Fig.6.6-D) – Resets the value of the

Controller's General Purpose Internal Registers .
“Run After Download” (Fig.6.6-E) – At the end of the download, sets the

Controller in “Run” modality (execution of the Program).

4.17 DEBUG MODE

By this modality it is possible to follow the Program flow and to monitor
in real time the Controller's status and the value of the Internal Registers.
When the Program is interrupted the Register Table is updated to the
last reading.
During the development of the Program, if the Controller is connected,
click on the  “Debug” button (Fig.6.7-A) to activate the “Debug” modality.
In the Status bar the message “Debug Mode” (Fig.6.7-B) will be visualized
and in the Tool bar will be activated the commands to execute the
following debug operations:
Run (Fig.6.7-C) :Executes the Program continuously.
Run To Break (Fig.6.7-D): Executes the Program up to the Break point .
Pause (Fig.6.7-E) :Interrupts the execution of the Program ( “Run”

condition) / executes  the Program step by
step (“Stop” condition)

Animate (Fig.6.7-F) Simulates the evolution of the Program flow
executing it step by step.

Stop (Fig.6.7-G) :Blocks the Program and reset it to the first
Function Block.

The Function Block in execution is identified by the Index parameter
coloured in red and is updated the PC (”Program Counter”) value
(Fig.6.8-A).
Open the “Settings” window (Fig.6.9), selecting “Settings -> Workspace”
to set the following options for the Debug modality:
“Run-Time Register Update” (Fig.6.9-A) – If active, in “Run” condition the

table Register will be automatically updated  (1 read per second)
“Animate Time” (Fig.6.9-B) – Setting of the playing time between one

step and the successive in the “Animate” condition.
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4.18 RELEASE MODE

After the phases of development and Debug it is possible to proceed with
the  “Release” modality, clicking on the “Release” button (Fig.6.10-A).
In the Status bar the message “Release Mode” (Fig.6.10 -B) will be
visualized and in the Tool bar the commands relative to the operations of
Debug and Download will be disabled.
In the “Release” Modality, at the power-on, the Controller will be
automatically set in “Run” condition, loading in the RAM memory the
Program saved in the Internal Flash memory.
In this modality it is possible to read and write the Internal Registers.

4.19 INIT MODE

The “INIT” modality can be used in case of fortuitous loss of configuration
to set the Controller in the default condition in order to recover the desired
configuration. In this modality the value of the following parameters of the
controller will be automatically set independently of the configuration saved
in Eprom.
IP Address Value assigned automatically from the network by

a  DHCP server
Modbus Node 0x0Ah (10)
PORT 0 (Slave) Baud-rate = 9600 bps

In this modality is not possible to execute the Program (Run) and the
Debug functions are disabled but it is allowed  to download the Program, to
read and write the Internal Registers and the Gateway function is enabled.

IMPORTANT:
In “Debug” modality, at the power-on the Controller will be auto-

matically set in “Stop” condition without load and execute the Program. For
such reason, at the end of the Debug operations, set the Controller in “Re-
lease” modality.

In “INIT” modality is not possible to execute the Program (Run) and
the Debug functions are disabled but it is allowed  to download the Pro-
gram, to read and write the Internal Registers and the Gateway function is
enabled.
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4.20 SCHEDULER (Data Logger)

The scheduler allows to manage up to 8 tasks of recording at the same
time (data-logger).
The data will be saved on the USB memory in .CSV format; it is possible
to get access to all of the files contained in the memory card by a page of
Web Server.

Open the “Scheduler” window (Fig.6.14), selecting “Tools -> Scheduler”
(Fig.6.13) to insert the tasks relative to the data-logger.

To insert the “Logger” object, click on the “Logger” button (Fig.6.15A) and
then click on the “Insert Object” button (Fig.6.15B) . The “Logger” text will
appear inside the “Task List” (Fig.6.15C) .

For each task it is possible to set:
Lifetime (Fig.6.16A): indicate the period of validity of the task, that is active

only in the period of time included in these parameters.
Directory of destination (Fig.6.16B): indicates the directory inside which

the files of the current task will be created. If the
directory doesn't exist, it will be automatically created.

File generation options (Fig.6.16C): the current file will be closed and a
new file will be created in function of the parameter of
time selected (hour, day, month and year). To the new
file generated will be assigned a name in function of
the date and time when it has been created  (ex: a file
created the day May 8th 2010 at the 14.00 will be
named as “08051014.csv”).

Recording Time (Fig.6.16D): if the “Time” option is set, a record of data
will be saved at regular intervals each time that the
selected period is expired.

Recording Trigger (Fig.6.16E): if the “Trigger” option is set, a record of
data will be saved at the variation (rising or falling
edge) of the bit indicated.

Record format (Fig.6.16F): the indicated values will be used to create the
fields that compose the record of data.

It is possible to insert the following parameters:
- Event type : identifier number for the event that enabled the
saving of the record of data (2 = trigger (rising edge of bit) ;
4 = trigger (falling edge of bit)  ; 128= recording time.
- dd/mm/yy : date;
- hh:mm:ss : time;
- Var[n] : value of the variable n (register).

To modify the format of the variables click on the “Set Formats” button
(Fig.6.16G) (refer to the section “Insertion of Variables”.

To confirm the task settings, click on the “Apply” button (Fig.6.16H).
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4.21 INSERTION OF VARIABLES

By this window (Fig.6.17) it is possible to indicate which registers will be
available for the data-logger functions. For each register must be
specified the number of the register (Fig.6.17A), the format type of the
register (Fig.6.17B), the numeric format (Fig.6.17C) and an eventual label of
description (Fig.6.17D).
To confirm the modifies of the register properties  click on the “Set”
button (Fig.6.17E).
To scroll up or down the register list click on the “Up” or “Down” buttons
(Fig.6.17J).
To add or remove a register click on the “+” or “-” buttons (Fig.6.17I).
When all the registers have been inserted, click on the “Write” button
(Fig.6.17G) to save the data inside the Controller.
To modify the values it will be possible to reload the project or read them
directly from the Controller clicking on “Update” button (Fig.6.17F) .
To close this window click on the “OK” button (Fig.6.17H) .

IMPORTANT:
The device doesn't execute automatically the change to the Day-
light Saving Time (DST).
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5 WEBSEVER

With Webserver extension is possible configure the network and services and download the data
stored in USB memory

The TU RS485/ETH have a factory IP Address 192.168.100.110, to change it use DevTU tool or enter
in Network web page in maintenance section

5.1 Operating environment

Supported browser:
 IE9
 FireFox
 Goole Crome

5.2 User Management and security

The system have different user for different function explained below
User Type Description
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User 1 End User 1 X - - - X
System User System User X X X X X
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5.3 Log-in

Initial page that appear after a remote connection
Initial user and password are
Level User Password
Normal User user1 user1_
Administrator admin admin_

The data on screen are :
 User Name : User name for log-in

 Password : Password for the user

to identify the right user (see User Management and security)

5.4 Navigation

On the top of the page there are buttons for web navigation

 Download : used for download data logged in .csv file
 Maintenance : enter in installation/maintenance utility, the functions enabled depend of user log-in
 Logout : come back in log-in page
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5.5 Maintenance

In this section is possible set all the service and function.
Every user have different responsabilty and can do different thing
User 1 ,

Admin System
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5.5.1 Information

In this section It’s possible set Network setting and system information

5.5.1.1 Network
CAUTION this setting will reboot the RCU and be shure that MCB is in off condition

 Dynamic IP (DHCP) : Used to get automatically IP configuration for a network DHCP
server

 IP Address : Network Static IP address for this unit

 Gateway : Network Gateway address IP Address
(necessary for go out local LAN)

 Subnet Mask : Enter Subnet  Mask

 Primary DNS : Enter primary DNS server IP Address

 Secondary DNS : Enter primary DNS server IP Address

 Update BUTTON : Confirm and save IP setting

 Return BUTTON : Come back previous page without save data

CAUTION: This configurations mast be confirmed by local LAN System administrator people

After configuration you can open a browser (es Internet explorer, Firefox,…) an type on url the IP address
setting (ex: http://192.168.100.113 )
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5.5.1.2 E-Mail

Mail service is a very powerful and flexible service.
With this service, TU RS485/ETH can send an email with a preformatting text up to 5 different email address
after a trigger signal occurs
Trigger signal can be:

 After a scheduled timer

 Changing a bit status in the project
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Mail Address
 From : is an email addres tha rappresent the sender

 To :Is the main address to be sended the alarm information

 Cc :Is like “sen in copy” so send the same email sendend to main address

Message

Is the section to compose the message

 Subject : is subject of email

 Body :Is the body of the email, here will be the real dynamic message

An example of body text is

Place: #037

Country: #038

Model: #035

S/N: #036

-Alarm Status-

1)#041

2)#042

3)#043

4)#047

5)#048

6)#049

7)#050

The body can be filled with static text and variable text

Ex “Place:” is a static text and “#037” is a variable text

The text in variable are defined in the internal project

The maximum number of variable in a project are 96 and the maximum number of fixed string are 128
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5.5.1.3 DDNS

 Status : if checked DDNS function is enabled

 DDNS Service : fixed to www.dyndns.com

 Remote server : DDNS server for service

 User : user for DDNS service (created on www.dyndns.com website)

 Password : Password for DDNS service

 Test : Give a status after a DDNS request
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5.5.1.4 Advanced
This section there is system information and special parameter
Admin System User

Advanced Information
 Web Version : Revision of Web Page

 Firmware Ver. : Revision of Firmware

 MAC Address : MAC Address of Ethernet board

 Host Name : Host (NETBios) name in the network

 Socket Time Out : Maximum time for the Remote connection

5.5.2 Users

Is possible modify the user name and password of every user.

User1 Level

Admin System User and Factory User Level
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5.6 Download

In download section is possible download data-log files

Filter
 From : start data for search filter

 To : end data for search filter

 Refresh : button for execute search filter

To change the value of Month and year click on buttons

Container

is the actual container of data
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File list

is the list of sub container or file logs (.csv)

 To download Files: click on Button

 To delette Files: click on Button
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6 TROUBLESHOOTING

6.1 ERROR MESSAGES IN THE LOG WINDOW AND IN THE STATUS BAR

EVENT POSSIBLE CAUSES POSSIBLE SOLUTIONS

“Not Connected”. -The Controller is not connected.
-The communication channel selected
 has not been enabled.

-Verify in the “Settings” menù :
for Ethernet port:
-IP address
-Port number reserved to the Modbus
  TCP socket (Port)
-Time out value.
-Modbus node ID of the device.

for serial port (COM):
-COM port number.
-Baud rate.
-Modbus node ID of the device.

 “Com Error”. -Wrong setting of the Ethernet port's
 communication parameters.
-Wrong setting of the Slave port's
 communication parameters.
-Wrong command addressing on the
 Master port.

-Verify in the “Settings” menù :
for Ethernet port:
-IP address
-Port number reserved to the Modbus
  TCP socket (Port)
-Time out value.
-Modbus node ID of the device.

for serial port (COM):
-COM port number.
-Baud rate.
-Modbus node ID of the device.

-Verify in the “Config” menù :
-Modbus node ID of the device.
-Baud rate.
- Delay of receiving (Slave port)

If the parameters have been correctly set
check the connection of the device

 “Com Timeout”. -With communication channel configured,
indicates a missing reception of the
response by the device.
-Wrong communication parameters.

-Verify in the “Settings” menù :
for Ethernet port:
-IP address
-Port number reserved to the Modbus
  TCP socket (Port)
-Time out value.
-Modbus node ID of the device.

for serial port (COM):
-COM port number.
-Baud rate.
-Modbus node ID of the device.

“Label error”. -One or more errors occur inside a
Function Block when the Program is
compiled,downloaded or verified.

-Check the parameters of the Function
Block identified by the index number
visualized inside the log window. (refer to
the sections 2.3 and 4.2).
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6.2 ERROR MESSAGES INSIDE THE POP-UP WINDOWS

“Controller not connected”.

“Timeout”. -The response provided by the Controller
 is not correct and the communication has
 been interrupted.

“Wrong response (function)”. - The Modbus slave device asked by the
 Controller doesn't provide a correct
 response.

-Verify in the “Config” menù :
-Modbus node ID of the device.
-Baud rate set for the Slave device.
- Delay of receiving (Slave port)
- Stop bit, Parity type.
- Number of the registers read or written.
-Modbus function code transmitted.
- Delay of receiving (Master port)

“Check values”. - One or more parameters of a Function
  Block are not correct; this error occur
  when the user clicks on the “OK” at the
  moment to insert the Function Block in
  the Program.

-Check the parameters of the Function
 Block: for the functions of external
 reading and writing, refer to the User
 Guide of the Slave device in use.

EVENT POSSIBLE CAUSES POSSIBLE SOLUTIONS

-The Controller is not connected.
-The communication channel selected
 has not been enabled.

-Verify in the “Settings” menù :
for Ethernet port:
-IP address
-Port number reserved to the Modbus
  TCP socket (Port)
-Time out value.
-Modbus node ID of the device.

for serial port (COM):
-COM port number.
-Baud rate.
-Modbus node ID of the device.

-Verify in the “Settings” menù :
for Ethernet port:
-IP address
-Port number reserved to the Modbus
  TCP socket (Port)
-Time out value.
-Modbus node ID of the device.

for serial port (COM):
-COM port number.
-Baud rate.
-Modbus node ID of the device.

-Verify in the “Config” menù :
-Modbus node ID of the device.
-Baud rate.
- Delay of receiving (Slave port)

If the parameters have been correctly set
check the connection of the device
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6.3 POSSIBLE CAUSES OF FAULT

Is not possible to power-on the
Controller.

-The Controller is not correctly powered.
-The value of the power supply value is
 lower than the specifications limits.

-Refer to the data-sheet of the Controller
 in use and verify the relative Technical
Specifications.

There is not communication between
the Host PC and the Controller.

-Ethernet port not correctly connected.
-Modbus Slave port not correctly
 connected.
-Eventual interface between PC and
 Controller not correctly connected.
-Wrong communication parameters.

-Refer to the section 7.1
-Refer to the data-sheets of the Controller
 and the Interface device in use.
-Refer to the section 8.1 .

There is not communication between
the Controller and one or more
Modbus slave devices.

-Modbus Master port not correctly
 connected.
-The slave device is not correctly powered.
-The slave device is not correctly
 connected on the RS-485 serial line.
-Wrong communication parameters.
-The Modbus addresses of the slave
 devices connected are not included in the
 range set in the System Register %S17
 (Gateway Mask) .

-Refer to the section 8.1
-Refer to the data-sheets of the Controller
 and the Slave devices in use.
-Slave device in INIT condition and Baud-
 rate of communication different of 9600
 bps.
-Verify the values of Gateway Mask.

The Program is not correctly executed
or it is impossible to execute the
Program.

-Wrong communication parameters.
-The Controller is in “Debug” modality and
 in Halt, Stop or Break Point condition.
-Wrong data-format of the Registers.
-Wrong parameters of the Function Block.
-Controller in Stack Overflow condition.
-Parameters of the eventual Slave
 devices connected not correctly inserted.
-The Program has not been downloaded
-Controller in INIT modality.

-Refer to the section 8.1
-Set the Controller in “Debug” modality
and in “Run” condition or in “Release”
 modality.
-Remove eventual Break Points.
-Set the correct data-format of Registers.
-Verify the parameters of Function Block
(data-format, masks, tables, etc..).
-Control, in the Program, the correspon-
dence between Call and Return.
-Control the configuration of the Slave
devices ( type of input and output, etc..)
-Download the Program.
-Control if the INIT modality is active.

The configuration of the Controller is
unknown.

- -Set the Controllore in “INIT” modality; the
 parameters of configuration of the
 Controller will be forced to the default
values listed in section 6.6 .

The Controller is connected in “INIT”
modality but is not executed (where
foresee the LED “STS” doesn't blink)
or there is not communication between
the Host PC and the Controller.

-Controller not correctly connected.
-Wrong port Baud Rate.

-Connect the terminal INIT to GND.
-Switch-off and than power-on the
 Controller after the connection of the
 terminal INIT to GND.
-Set the Baud-rate of the Slave Port as
 9600 bps.

The functions Clock and Calendar
(where foresee) don't work correctly.

-Battery low or absent.
-Clock and Calendar parameters not
 correctly set in the proper Registers.

-Change or insert the battery.
-Control the parameters of the System
 Registers (refer to the sections 3.3
and 3.4).

The function “Search” doesn't find
any Controller.

-There are not Controllers connected.
-Controllers not correctly connected.
-The Controllers connected by Ethernet
 port has been set  with communication
 parameters not compatible with the
 Ethernet interface of the Host PC in use.
-On the network are active Firewall or
 Routers that block the access to the
 Controller.

-Refer to the data-sheet of the Controller
in use and verify the relative Technical
Specifications.
-Verify the parameters of the Ethernet
interface of the Host  PC.
-Call the System Administrator in order to
connect the controller to the network.

EVENT POSSIBLE CAUSES POSSIBLE SOLUTIONS
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6.4 Warranty condition

CD Automation gives a 12 months warranty to its products.
The warranty is limited to repairing and parts substitution in our factory and
does exclude products not properly used and fuses.
Warranty does not include products with serial numbers deleted. The faulty
product should be shipped to CD Automation at customer’s cost and our Ser-
vice will evaluate if product is under warranty terms.
Substituted parts remain of CD Automation property.

The function “Search” doesn't find any
Slave device.

-There are not slave devices connected .
-The slave devices are not correctly
 connected.
-The Controller which the slave devices
are connected to has not been selected.
-The Modbus addresses of the slave
 devices connected are not included in the
 range set in the System Register %S17
 (Gateway Mask) or in the range set in the
 menu “Search”.
- The baud-rate of the Slave devices
  connected is not the same of that set for
the Master port of the Controller.

- The Timeout values are not correct.

-Refer to the data-sheets of the slave
 devices in use and verify the relative
 Technical Specifications.
-Verify that the Controller selected is the
same which the slave devices are
 connected to.
- Verify the correspondence between
 settings and Modbus addresses of the
 slave devices.
-Verify the values of Gateway Mask.
-Control the baud-rate and delay time of
the slave devices connected.

The data saved as Kostant in the
Register table, are not saved when the
Controller is switched off.

-The data have been saved in General
 Purpose Registers instead  Retentive
 Registers .

-Save the kostant values in Retentive
 Registers.

The Web Pages haven't been loaded. -The IP address written in the address bar
of the Internet browser is not the same of
 Controller's IP address.
-The Controllers connected by Ethernet
 port has been set  with communication
 parameters not compatible with the
 Ethernet interface of the Host PC in use.
-On the network are active Firewall or
 Routers that block the access to the
 Controller.

-Verify the IP address written in the
 address bar.
-Verify the parameters of the Ethernet
interface of the Host  PC.
-Call the System Administrator in order to
connect the controller to the network.

EVENT POSSIBLE CAUSES POSSIBLE SOLUTIONS
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CD Automation s.r.l. reserves its rights to modify its products totally or in part without notice at any time.


